CHAPTER ©

Groove Server 2007:
Mastering the Groove

There are usually three sides to every deployment: the
installation, the configuration, and the client. In the previ-
ous two chapters, we discussed the installation and config-
uration of your Groove Manager, Relay, and Data Bridge
servers. In the event you need these servers in-house, you
should have no difficulty establishing your server base,
ensuring network functionality (by opening the correct
ports through firewalls and so forth), or maintaining a
connection between your Groove environment and your
Active Directory (AD) environment, which are distinct. For
most Groove setups, you are complete.

However, there are branches that come off of the base
we’ve given you. This chapter explains how to use your
Groove client and what else your Groove structure can be
used for, and finishes the discussion about Groove with a
solid explanation of how to use the Groove client.

Working with the Groove Client

Some may consider the Groove client to be self-explanatory.
They, like all presumptuous software users, will certainly be

able to “get it to work,” but will most likely be missing out

on some of the finer features. But, admins should be up-to-

date on what Groove clients can do, and how to do it.

To begin with, let’s create our first Groove workspace.

IN THIS CHAPTER

» Working with the Groove Client
» The Groove Client Possibilities
» Groove Accounts and ldentities

» The World of Groove
Development

» The Ten Habits of Highly
Successful Groovers

» Groove in a Nutshell



148 CHAPTER 6 Groove Server 2007: Mastering the Groove

The Groove Launchbar

When you start your computer with Groove 2007 installed, you will see a Groove icon in
your taskbar, and the Groove Launchbar (shown in Figure 6.1) will be available by default,
although you can alter these startup options. In the event you have disabled your taskbar
application icons, which are popular these days, you can always launch Groove through
your Programs, under Microsoft Office.
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FIGURE 6.1 The Groove client Launchbar.

You can find everything you need to get started with Groove on the Launchbar. You'll
notice that you have two tabs, one for Workspaces and one for Contacts. To alter the
appearance of your Launchbar, select the Options menu and turn off Tabbed View. This
action stacks both the workspace and contact portions together.

There are different ways to create a new workspace. From the Launchbar, you just click the
New Workspace link at the top. Or, select the File menu and choose New — Workspace.

You will be presented with the option to create one of three types of workspaces, as
shown in Figure 6.2:

» File Sharing. This type let’s you share the contents of a folder with all computers
that you hold a Groove account on or with other users you invite. A file-sharing
workspace will appear in your Launchbar under its own heading, to make these
workspaces easier to find and sort. If you choose this option, you can select an exist-
ing folder for sharing, or create a new folder that can be automatically placed on
your desktop (or wherever you choose).
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» Standard. This type let’s you work with a Files tool and a Discussion tool. You can
add more tools if you like. This is the quickest way to create a functioning work-
space. When it is up and running, you can make configuration changes.

» Template. This custom type let’s you choose the initial set of tools within the work-
space. Suppose, for example, you just want a workspace for playing chess (yes, an
option). You can create one specifically for this purpose and not have to have the
Files and Discussion tool in your initial workspace. You can also find other work-
spaces that you might have saved as templates and use those, with the tools already
in place.

NOTE

Because the added documents and such within a workspace are not kept on a server,
usually, but within each person’s workspace so that he or she can work on individual
pieces when not able to connect to a Groove server, that workspace might grow quite
large over time. Although no specific size restriction applies to workspaces, it is
recommended that you limit your size to 2GB or less. Beyond 2GB and Groove will not
even be able to include new invitees to your workspace. To view the size of a work-
space, just right-click the workspace from the Launchbar and choose Properties. The
size is on the General tab.
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FIGURE 6.2 Choosing your workspace type.

Quick Access to Workspaces

Laurent Kempé, in his blog at http://weblogs.asp.net/lkempe/default.aspx, provides
some advice about how to launch a workspace faster than using the Groove Launchbar
(upgraded here for Vista):

1. Select the Start orb and go to your Documents folder.

2. Create a folder and call it GWS (for Groove workspaces), or something of your
choosing. In your GWS folder, you might create additional folders to classify your
workspaces.
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3. Open the Groove Launchbar.

4. Select one workspace and drag it to the folder you just created. Automatically, a
shortcut will appear.

5. Continue doing so for all workspaces you want to have access to.
6. Right-click the taskbar and choose in the context menu Toolbars, New Toolbar.

7. In the dialog, browse to Documents, GWS, and then click OK.

You now have a new toolbar called GWS in the window’s taskbar that let’s you choose a
workspace without running the Groove Launchbar.

Working within Your Workspace

A Groove workspace is intuitive and well designed. As you can see from Figure 6.3, you
have your workspace members located within a pane on the right, where you can easily
add more members to the workspace or chat with existing members. In the Common
Tasks pane, you can establish roles, add new tools, send messages, and so forth. And
finally, the primary portion of your workspace involves the tools you have available.

As you can see from the figure, the default tools provided include the following.
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FIGURE 6.3 Choosing your workspace type.
» Calendar. Mark important dates and build collaborative schedules with workspace
members.
» Chess Game. Play a game of chess without the distraction of the rules.
» Custom. Choose from any of a wide variety of tools.
» Discussion. Engage in detailed conversations with other workspace members.

» Files. Store, organize, and share files.
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» Forms. Create customized applications for collecting and viewing data.

» InfoPath Forms. Create customized tools based on Microsoft InfoPath 2007 form
templates.

» Issue Tracking. Report, manage, and track the status of issues and incidents.
» Meetings. Assign agenda and action items, record meeting.

» Notepad. A simple text editor that allows all workspace members to see what has
been typed.

» Pictures. Display and share graphic images and digital photos.
» SharePoint Files. Synchronize files with a SharePoint document library or folder.

» Sketchpad. Use drawing tools on a sketchpad.

To add any of these tools to your workspace select the Add Tools option and click the
check box next to the tool. You can also click the button in the lower corner of your
primary workspace window

NOTE

Many who see the long list of tools available have one question on their mind: How
can | create my own custom tool? There are a couple of Groove tools you can use.
One is the Groove Forms tool, which developers can use to lay out all the design
objects through the Design Sandbox, which provides the environment for tools
creation. Another tool you can use is the Groove InfoPath Forms tool. This tool works
hand in hand with the InfoPath 2007 tool. Essentially, the InfoPath 2007 tool enables
you to define your fields and form layout and then creates an XSN template that can
be imported into the Groove InfoPath Forms tool. Then, the developer can add similar
features that would be added within the regular Groove Forms tool (such as views
and macros).

NOTE

For anyone who is truly looking to build applications for Groove, you should really
consider the new Silverlight tools that Microsoft has recently released. You can find
one excellent resource, posted by Hugh Pyle, at http://blogs.msdn.com/hughpyle/
archive/2007/06/21/silverlight-in-groove.aspx; this will point you in the right direction.
He shows you an easy approach, complete with some code examples.

You might find the Discussion tool interesting because of its ability to be modified
through the Design Sandbox (see Note). From within the Discussion tool, select the
Designer menu option and choose Open Design Sandbox. This will take you to the
settings shown in Figure 6.4, which you can then modify directly.
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FIGURE 6.4 Working with the Design Sandbox for the Discussion tool.

Sometimes you might add too many tools into your workspace. To remove some of your
unnecessary tools, right-click the Tool tab at the bottom of your screen and select the
Delete option. Or, select Delete Tool from the File menu.

If you want to quickly enter a workspace from within the tool you need the most, select
File, Save Shortcut to Desktop; the shortcut will be right on your desktop for quick
access to the workspace and the tool.

Managing Workspace Invitees

A workspace is only as useful as the people you've invited into it. Sometimes you only
need one other person. Other times, you invite an entire team, or people from other
branches (really ... whatever is needed at that time).

So, how do you add participants? Well, after you have the workspace established, you
want to open the workspace, and from the Workspace Members pane put the name or
email address of the recipient of the invitation in the Invite to Workspace box. Note that
if you type a name, Groove will look for a Groove contact to send the invitation to. Or,
you can just select a contact from the Groove contact list if a name cannot be located.
When you find the person, or put in the email address, click Go to open the Send
Invitation dialog, shown in Figure 6.5.
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Send Invitation - Microsoft Office Groove [=sEo =
To: jpb@diptraining.com - Add More...
Workspace: ClipTraining Author Pool

Message:

hed) (0] (=]

You are being invited to join the Clip Training Author Pool
so thatwe can better collaborate on various projects in the
future.

Please acceptthis invitation to join the workspace.

[¥]Require acceptance confirmation Invite Cancel

FIGURE 6.5 Sending invitations to join a workspace.

At this point, you need to assign a role to the person (which we discuss shortly). Select a
role (Manager, Participant, or Guest), and select the Require Acceptance Confirmation
check box if you want to be able to confirm the acceptance of the invitation. If you select
this option, it is more than just a helpful notice for you (because you would already know
whether they accepted the invitation by the fact that they would now be part of the
workspace members, even without this option being selected). It is also a security measure
because you will now have to accept the recipient’s response and confirm the identity of
the person. If an invitation is sent through email, it’s automatically configured to use the
confirmation of acceptance option. The recipient must confirm the invite.

You are also welcome to add a message (perhaps explaining the invitation to the work-
space as an “official” invitation). And finally, you click the Invite button to send the
invitation.

NOTE

Groove sends the invitation to the person(s) using one of the following methods: For
Groove contacts, the message goes out as a Groove message. For email addresses,
the message goes through Outlook as an email with a file attachment. If you aren’t
using Outlook, you are informed that Groove cannot send the invitation automatically.
You can then copy the invitation and paste it into another email application you have
running to send to the user. To do this, don’t close the invitation. Instead, just select
File, Copy Invitation to Clipboard.

The invitation includes instructions for persons with Groove and for those who haven’t
installed it yet. Those who already have Groove can click a link to open the invitation.
Those who don’t yet have Groove can click a link that takes them to a Groove download
page. After Groove has been installed and is up and running, the invitation will open
automatically (or can be reinitiated through the original email received).
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Workspace Roles and Permissions

Everyone who participates within a workspace belongs to a role. Each role has specific
permissions within the workspace. The roles and their permissions are as follows:

» Manager. The creator of the workspace is automatically given the manager role.

You have permission to change the roles of others, send invitations to others, and
so forth.

» Participant. A participant has permissions to interact within the workspace, invite
other members, and add tools to the workspace.

» Guest. A guest has no additional permissions.

Each tool within the workspace has its own permissions that determine what a manager,
participant, or guest can do with the tool. To alter the permissions for a tool, open the
File menu and select Properties, Tool. The Permissions tab will then open, as shown in
Figure 6.6. From here, you can select the down arrow under Select a Role to Modify Its

Permissions and choose the role. Then, select or deselect various permission settings and
apply those settings.
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Every member in the workspace is assigned a role. Each role has different permissions assodated with it.

Select a role to modify its permissions:
Fienzger I~]

Add filesfsubfolders
Modify files

Modify own files
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Delete own files/subfolders
Modify permissions
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FIGURE 6.6 Modifying tool permissions based on the three built-in roles.

Changing Workspace Settings

Each workspace has its own settings. To see/alter these, open the File menu and select
Properties, Workspace. Or, from the Launchbar, right-click any of the workspaces and
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select Properties. From here, you will see four tabs (General, Alerts, Roles, and
Permissions) that relate to the entire workspace.

General Tab
From within the General tab of the workspace properties, you can see the following
information:

» Version. Shows you the version of Groove used when creating the workspace.
» Size. The current size of the workspace.

» Template. The version number of the workspace template.

» Created by. The name of the person who created the workspace.

» Created on. Displays the date the workspace was created.

» Requirements. The minimum version of Groove required for access to all workspace
and tool features.

» File-sharing properties (only applies to file-sharing workspaces), the Properties
dialog box, and a Folder Info and a Status tab. These tabs provide information
about the path of the root folder currently being synchronized, excluded files and
file extensions, and the current synchronization status.

You can alter the version requirement, if other versions exist in your environment. You
can also add a description about the workspace within the Description text box.

Finally, you can select the check box Download Automatically onto All My Computers.
If you select this, the workspace (and its contents) will be downloaded to any computer
where you log in to Groove with your account.

Alerts Tab
The Alerts tab, shown in Figure 6.7, allows you to configure Groove to notify you regard-
ing unread information in workspaces or when persons sign in to their Groove workspace.

You can choose from four alert levels, with a reaction and sound you can associate with
the alert:

» Off. Doesn’t display an alert for new or modified content
» Medium. Highlights unread content with an icon
» High. Display an alert for new or modified content

» Auto. Similar to High, but auto-dismisses ignored unread alerts

You can select the Notify Me When Any Member Enters This Workspace check box and
associate one of the standard sounds available or browse for a sound of your choice.
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FIGURE 6.7 Working with alerts for your workspace.

Roles Tab
The Roles tab shows you every member in the workspace and the role that each currently
holds. You can select a member and change that member’s role if you like.

Permissions
Unlike permissions for a specific tool, these permissions relate to the workspace itself.
There are five different permissions:

» Invite

» Uninvite

» Add tool

» Delete tool

» Cancel all outstanding invitations

As discussed previously, the manager role holds all five permissions for the workspace.
The participant holds the invite and add tool permissions. The guest holds no permis-
sions. However, you can change that for your workspace by selecting/deselecting the
check boxes next to each permission.

The Groove Client Possibilities

This part of the chapter focuses on the workspace world and how to manage some of the
features. There is something to be said for each one of the tools at your disposal and how
they work. The Groove help files are pretty thorough in their explanations. Logically, you
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would concur that the Chess tool is not going to be as helpful in business as the Meetings
tool, but each tool expands possibilities for your communication and collaboration (some
more so than others). Let’s consider some of the more robust tools available.

Making Your Meetings Groovy

One of the more impressive Groove tools is the Meetings tool. This tool helps you orga-
nize, conduct, and even record meetings for workspace members.

Both managers and participants can create a meeting as follows:

1.

2
3.
4

Select the Meetings tool.

. In the upper-left corner, select New Meeting to start the Meeting Wizard.

Enter a subject and start and end times for the meeting.

. You can add a location, meeting details, and even attachments that may be

necessary to read before or during the meeting.

Click OK to create the meeting.

After the meeting has been established within your workspace tool, you can select that
meeting and see five tabs that will help to make that meeting more “groovy,” as follows:

>

Profile. Contains the start and end dates and time of the meeting, along with the
location, attachments, and details.

Attendees. You can edit the attendees through this tab. By default, any attendee
whose role is participant or higher can edit the tab. Just click the Edit button and
make the changes you want. Attendees are only restricted to members of the work-
space. From the Attendees tab, you can select who should attend the meeting,
whether they are the chairperson or the minutes taker, and any notes you want to
pass on to them.

Agenda. To construct the agenda for the meeting, click the New Topic button and
specify the start and end times and the topic and presenter for that portion of the
meeting.

Minutes. During the meeting, the person who is elected to take the minutes can
actually use the Minutes tab to work with the agenda and type the notes directly
into Groove. Just type the notes for each agenda item as you go. And then, you can
save the notes for others to view.

Actions. Actions are essentially a list of items that must be handled as a result of the
meeting. You can establish a priority for the actions and monitor their completion
levels.
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NOTE

One of the best aspects of the Meetings tool, according to the popular site
TheNewPaperClip.com, is the fact that everyone will have the same record of the
meeting and its resolutions ... immediately after the meeting has concluded. No need
to wait for the secretary to complete and edit the notes and send them to all atten-
dees. And, the best part of all of this is that you can invite new persons into the work-
space, and they can go back and read the history of previous meetings.

Integrate Groove with SharePoint

At times, envisioning ways to implement new technology is easy. Often, you have a need,
and the software fills that need; so, it’s a no-brainer. Other times, however, you might
already have systems in place (workarounds, if you will) that now hinder your ability to
visualize how the new software might benefit you. For example, although you might see
the immediate benefit of Groove, especially in working with clients who are outside your
corporate structure, you might not see where SharePoint and Groove can work together.

The best Groove site on the Internet these days is, hands down, the Groove Advisor
(http://blogs.technet.com/groove/default.aspx), which is one of the MSDN blogs that
Microsoft promotes. One scenario presented involves a situation in which a person uses
Groove workspaces to communicate with 15 different partners. Essentially, he has 15
different workspaces, 1 for each partner. But, he wants to distribute the same document to
all 15 partners. He could just use the workspaces to do this, posting the document to all
15. This would work, and probably is what most of us would do. (Again, it’s hard to envi-
sion new uses.) But, a question arose: Is there a better, more efficient method?

The solution involves taking those 15 workspaces and connecting them to a single
SharePoint document library. The Groove Advisor makes it clear that the partners are not
connecting to the SharePoint library; that is your responsibility. “The library basically
seeds/feeds the workspace with new documents/content.” When changes appear within
the workspace, Groove takes over and ensures that the documents are in sync with work-
space members.

To accomplish this goal, you need to add the SharePoint files tool to your Groove
workspaces and establish synchronization between the tool and the SharePoint library.
(Logically, you need the SharePoint library, too.) The user doesn’t have to update each
client, and only has to keep the one document up-to-date on the SharePoint server.

To configure the SharePoint Files tool within your workspace, follow these steps:
1. Select Add Tools, and choose the SharePoint Files tool.

2. You will be taken to a welcome screen, as shown in Figure 6.8. It says “This tool
allows teams to work together to produce and modify documents in SharePoint
libraries. While your team works in Groove, the documents are easily shared and
stored in SharePoint through automatic integration.” Click the Setup button.
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3. Either enter the URL or browse to locate the URL for the SharePoint site with the
library or folder that you will synchronize.

4. After you've located the library, select Open. You will now see the contents of that
library from within the SharePoint Files tool.
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FIGURE 6.8 Setting up your SharePoint Files tool.

After you have the connection made to your SharePoint library, you need to configure the
synchronization schedule that will be automatically kept between the files and Groove.
To set up a manual or an automatic schedule, follow these steps:

1. Select the Calendar icon located in the synchronization bar.

2. Choose Manually, if you want to manually synchronize your files, or Automatically,
if you want the automatic route (which is easier for you). Then, choose the Every (so
many number of time units).

3. Then click OK.

Now, even if you have everything working off a scheduled synchronization, you might
need to perform an immediate sync. No problem. Just choose Edit, and then select the
Synchronize Now option. The files are immediately put in sync.
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NOTE

Groove and SharePoint security concerns are a big question on many people’s minds.
Does Groove support SharePoint access control lists (ACLs) in the SharePoint Files
tool? Who can edit content in the tool? Who can access the tool? The blog Groove
Advisor addresses all of these concerns at http://blogs.technet.com/groove/archive/
2007,/04/02/groove-security-meet-sharepoint-security.aspx. According to the Advisor,
“Groove security and SharePoint security are configured and administered separately
and independently.” However, within a transaction, a Groove sync request and
SharePoint access can conflict. This is because the user who manages the workspace
and who has configured the SharePoint connection has one set of credentials on the
SharePoint side (at least read access to the content), and that allows the content to
be put within the workspace, but users within the workspace can come from anywhere
(so they logically have no access to that content). Outside users can modify, delete,
and so forth the content based on their Groove permissions, but this means nothing to
SharePoint. When the synchronization occurs, it occurs under the ACLs of the original
user and modifies the files based on the user who is the synchronizer. For more about
the subject, check out the Groove Advisor blog.

Groove Accounts and ldentities

To use the Groove client, you need an account. You also need an identity. Although these
might seem to be the same thing, they are actually quite different. Let’s explore the differ-
ence between accounts and identities and explore how to manage them.

Accounts and Identities

The actual account is a file stored on your system that includes the following informa-
tion, according to Microsoft:

» A Groove identity, or more than one identity, along with the private keys that
define those identities

» Cryptographic information, such as the master key to protect those workspaces
» Devices on which you operate Groove
» Workspaces that you are included as a member of

» Contacts you communicate with and their corresponding information

During the login process, your password or certificate (if you use a certificate) decrypts the
account file so that you can assume those identities it contains and access the informa-
tion within.

An identity, on the other hand, is the “electronic presence” that Groove users need to
interact with you. You can only associate identities with one Groove account, although
you can have multiple identities linked to that account. And, you can move that account
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across multiple systems if you like. By default, you are given an identity that just includes
your account name. You can leave this or change it to suit your needs. You can also create
more than one identity to link to your account.

Now, why would you want more than one identity? Well, with some persons, you might
want to be known by your official name, whereas with others you might be more relaxed
and want to use a more familiar name. It’s all about the persona you want to maintain
within the Groove workspace environment.

Each identity you create has a contact file associated with it that will provide others with
information about the identity. So, you can give out more or less information regarding
yourself depending on the identity you are using and the environment in which you
choose to use it. For instance, you might use one identity for a particular business venture
that uses the address and contact information for that business, but you might have
another identity for your actual place of employment that includes a completely different
set of personal information.

To add identities to your Groove world open the preferences either from the Launchbar or
from within a workspace. To do so, select Preferences from the Options menu. The first
tab is the Identities tab. A down arrow lists all your identities. To create a new identity,
click the New Identity button. You will then see all the information you can enter, as
shown in Figure 6.9.
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llJllanaRnse McGovern '] [ New Identity ]
Liliana Rose McGaovern/Cliptraining [ Edit ]
[ Delete ]
| Setas Default ‘
Irm @diptraining.com el this Contact
222 Dreamworld Ave -mal s Con
Orlando Florida 44444
UsaA Save this Contact as File
& 555-1212
List me in:

The Public Groove Directory:

‘Nn Listing v |

The local network directory:

[Al Contact Information -]

FIGURE 6.9 Creating a new identity.
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After you have the information included for the various identities you choose to use,
click the E-Mail This Contact link to send the identity card to another person’s contacts.
Alternatively, you can click the Save This Contact as File link, to save the identity as a
Groove contact file (.vcg extension) that can be sent to others.

Back Up Your Groove Account

You don’t want the problem of losing your account in one way or another. The disk
could crash, for instance, or you might have a corruption of the files. So, a good backup
is always the safest bet.

One easy way to have a secondary copy of your account is to add it to another computer.
As mentioned previously, you can use your account (with all your identities) on multiple
systems. To do that, you need to add the account to those systems, as follows:

1. From the File menu, select Use Account on Another Computer.

2. You will be presented with a set of instructions that explain that first you want to
save your account file and then copy it to another computer (see Figure 6.10).

3. Install Groove on the other computer.
4. Close the Account Configuration Wizard when it starts.

5. On the new computer, double-click the file, which should have been copied to the
new system. The file will have a .grv extension on it.

ClipTraining Authar Pool - Notepad - Microsoft Office Groove =[]
IE it View Format Options Help | i Workspaces ~ | [
Notepad Al Workspace Members
NewNote | B 7 U [@ » A® v MoreFontsi, | £ =SS i ity (# In Workspace
(@) Lilliana Rose McGovern/Cliptraining
No pages [ Edt ][ Delete ] & ot
(¥) Offline
¥ Did you know...
Use Account on Another Computer =]

You can share this workspace with someone. Type an
e-mail address or cantact name below to send an

To use your account on anether computer:
invitation.

1. Save your account file (Liliana Rose McGovern) and copy it to the other computer,
Tip: You may want to e-mail the saved account file to yourselfas a fie attachment

2. Instal Groove on the other computer,
3. If the Account Configuration Wizard starts, dose it.
4. Find and double-diick your account file.

Save my account file for copying to the other computer ‘|
G2\Jsers\PB\Desktop Account For Lillana Rose McGavern.orv |
Note: You can use your account only on computers managed by your erganization.
For more information, contact your Groove administrator.
Invite to Workspace: More
Enter name or e-mai- -
| Common Tasks
94 Tum Off Tool's Unread Alerts
£ Add Tools
,,,,, & View Workspace Properties
= Files |3 Discu... ||[ia] Pictures|{ 7 Sketc... || ] N.... 1 |2 Meeti.. ||/i#) Calen... | ] lssue ... |73 Share... I3 wite My Other Computers

=

FIGURE 6.10 Backing up and moving your account.
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NOTE

Saving the account doesn’t save the data. That data will have to be downloaded again
on the new computer, unless you have saved your workspace manually (discussed
later). However, one company that is providing a free backup tool for Groove 2007 is
ThreeWill (www.threewill.com). It's a command-line based utility for backing up your
Groove workspace(s). ThreeWill says, “You can use it to back up your Groove work-
space(s) to a particular location. You can use it to back up workspaces by name, or
you can back up all of your Groove workspaces at once. The included instructions and
online help show how to configure a scheduled automatic backup and how to set other
options. Options include the ability to specify the filename and the Groove account to
use for the archive, whether to include the members and/or data in the archive, a
passphrase to secure the archive, and whether to set the archive as read-only.”

If you just want to save your account as a backup copy, follow these steps:
1. Select Options, Preferences.
2. Go to the Accounts tab, shown in Figure 6.11.
3. Select Save.
4. From the Save Account As dialog, choose the location of the account file.
5

. Select Save.

() Preferences =]

[ 1dentities | Account [Security [ Alerts | Options | Synchranization

You can use the options below to manage your account on this computer.

[ Change Password... ]

Remember password
Enable password reset

Save Account as File

[ Save... ]

Delete Account from this Computer
[ Delete ]

Name Status TATOO:
B TATOOINE Ready
Status: Ready
Managed By: Cliptraining
‘ Remove Computer |
[ Rename Computer... I

S J—

FIGURE 6.11  Saving your account through the preferences.
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It is recommended that you save the account information to another location. In the
event of a system crash, the account will be safe either on a network server, another
system, an external drive, or a USB keychain. (The file isn’t very big.)

Note that you can do more than save the account; you have these options, too:

» Change Password. Select this option to change the password. You have to fill in the
Password and Hint fields.

» Remember Password (check box). Select this option if you want to log in to your
account later without having to enter the password again.

» Enable Password Reset (check box). Select this option if you want to be able to
request a new password or smartcard certificate from the administrator of your
account.

» Save. Already discussed above, this option enables you to save the account.
» Delete. Select this option to delete the account.

» Remove Computer. This option enables you to you eliminate a system that is
handling your account.

» Rename Computer. With this option, you can you rename the computer account.
(Note that this doesn’t actually change the name of the actual system.)

NOTE

Microsoft recommends users back up their accounts weekly. A weekly backup is espe-
cially important for users who are using Live Groove account configurations for which
there is no-behind-the-scenes admin to keep everything safe. If you are using hosted
services, however, or if you have established an in-house Groove manager, the admin
needs to back up the accounts. In the event of a crash, the user just requests the
account backup file from the admin or help desk.

To manually back up or archive your workspace, select File, Save Workspace As, Archive.
The end result will be a single binary file that includes the workspace data, membership,
tools, and more. Keep in mind that this copy will quickly become out-of-date. Microsoft
provides a special note in their documentation for restoration issues with the archived
copy. They remind us that the copy is not the current workspace (obviously). When the
workspace is restored, all the other members will appear as suspended because they don't
have this supposed new copy of the workspace on their systems (even though, its really
the old version).

In addition to ThreeWill, mentioned previously, a couple of other Microsoft partners have
workspace archive tools:
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» Dicodemy, GForce.Backup (www.dicodemy.net/ProductsAndServices/
GForceBackup.aspx). GForce.Backup is a personal backup utility for Microsoft
Office Groove 2007 that enables users to manage and restore archived workspaces
and automatically back up Groove workspaces that have changed, on a user-
defined schedule.

» Information Patterns, Toucan Bambuco (www.infopatterns.com/products/
ToucanBambuco.aspx). Toucan Bambuco is a middleware application that enables
you to back up your workspaces by invoking a simple script from the command
line or at predefined intervals through the Windows Scheduler.

Groove Security Settings

To configure security settings for a specific identity, select Preferences from the Options
menu. Then go to the Security tab, shown in Figure 6.12. From here, you can select a
down arrow and choose the identity.

[ Preferences @

| Identities | Accnul\tl Security ‘A[zr\'s | Options I Srynchmn'mt[nn‘

Security settings for:

[Lﬂhana Rose McGovern 'I

Digital Fingerprint
Use the following code to confirm to others that you are indeed who you say you are:

9f33-b63e:2917-967b:edda-c2ce:ef17-0bf2: 2dc1-9dff

Communication Policies

Allow me to communicate with;
@ Any contact without warning or restriction
() Any contact but warn me when communicating with contacts whose identities have not been verified
Only contacts whose identities have been verified by my organization

File Restrictions

Block restricted file types
View restricted types

Workspace Restrictions

Restore or join only Microsoft Office Groove 2007 (or later) workspaces

Learn more about these security settings

FIGURE 6.12 Security settings.

One item you can see is the digital fingerprint for each identity. These are created when
you create the identity. It’s a long, random number that is issued automatically. You can
use this number to verify other Groove users before accepting them into your workspace.



166 CHAPTER 6 Groove Server 2007: Mastering the Groove

Under Communication Policies, you have several options, including the following
settings under Allow Me to Communicate with:

» Any contact without warning or restriction (default). No warnings or restrictions
will be issued, regardless of the contacts verification status.

» Any contact but warn me when communicating with contacts whose identities
have not been verified. A warning is issued before you contact persons who don’t
satistfy the requirements. The warning displays in the Contact Verification Alert
dialog box, which provides an option for verifying these users.

» Only contacts whose identities have been verified by my organization. All
contacts you interact with must be certified by the Groove admin.

You can select the check box to Block Restricted File Types, and then see the restricted
files by clicking the View Restricted Types link. This will show you all the different files
that aren’t allowed.

Under Workspace Restrictions is another check box: Restore or Join Only Microsoft Office
Groove 2007 (or Later) Workspaces. This check box enables you to lock down the ability
to join workspaces created with earlier versions of Groove.

The World of Groove Development

As previously discussed, you can make changes to your Groove tools through the various
development tools at your immediate disposal. In addition, other solutions are possible—
customized solutions you can have your developers focus on. In harmony with that, a
great portal is set up on the MSDN sites for developers who need to create solutions for
the Groove platform.

Located at http://msdn2.microsoft.com/en-us/office/bb308957.aspx, the site also links to
relevant content on TechNet and Office Online, providing easy access to those materials.
The available information enables developers new to Groove to build a solid foundation
of knowledge before taking Groove deployments to the next level by planning, building,
and deploying customized Groove-based solutions.

Tools that you can use to work with Groove development include the following:

» Silverlight and Groove. Hugh Pyle discusses the possibilities of developing with
Silverlight on his blog, at http://blogs.msdn.com/hughpyle/archive/2007/06/21/
silverlight-in-groove.aspx.

The concept is simple. Silverlight is a plug-in that allows for vector graphics, anima-
tion, storyboards, and more ... all using .NET and XAML within a browser. Hugh
says, “Groove Forms has a relatively restricted set of user interface capabilities. It’s
designed for building reasonably straightforward UI for data capture in small teams.
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Forms with fields, views with columns, and a Groove workspace for distributed data
storage. But many applications would like to go beyond a simple forms-driven Ul,
and Groove Forms doesn’t make that very easy.” Using Silverlight in Groove Forms
would be a perfect combination, however. Hugh provides some good examples of
how this can be done.

» Groove with VSTO. Another development possibility is brought to us by Paul
Stubbs (author of the book VSTO for Mere Mortals: A VBA Developer’s Guide to
Microsoft Office Development Using Visual Studio 2005 Tools for Office) on this blog,
at http://blogs.msdn.com/pstubbs/archive/2007/05/21/groove-n-with-vsto.aspx.

He mentions talking directly to the Groove client by using VSTO from an Outlook
2007 add-in. He says, “First start by creating a new C# VSTO Outlook 2007 add-in.
The next thing you want to do is create a class library, called GrooveServices, to
isolate all of the Groove service code.” The rest is on his site to complete the
process.

You can find additional resources on the development site, including a grouping of arti-
cles from Chris Normal, the development lead on the Groove Team, on how to work
with Groove forms and Groove InfoPath forms, and more. So, if you are a Groove devel-
oper, or want to learn to become one, this site is a must.

You might also want to download the Groove 2007 Software Development Kit (SDK),
which can be found on Microsoft’s Web site. The kit includes samples and libraries to
help you develop Web services applications for Groove 2007. The SDK includes C#
samples and the Web Service Definition Language (WSDL) definitions for the Groove Web
services application programming interfaces (APIs). In addition, it provides local copies of
the Groove 2007 Web Services Developer Reference Guide and the Groove 2007 Forms
Developer Reference Guide.

Another set of tools are Web Helpers for Groove 2007, located at www.codeplex.com/
gwsvl12Zhelpers, which provide a C# .NET assembly that provides an abstraction layer for
Groove 2007 and Groove 3.1 Web services. The abstraction layer provides an easy-to-use
API with an object and eventing model, so that custom applications that interface with
Groove can be built more quickly.

NOTE

One company that has been developing with Groove in mind is Information Patterns
(www.infopatterns.com), with the new Toucan Navigate 2007. This tool blends
Microsoft Virtual Earth maps and imagery with geographical information systems (GIS)
files and spreadsheets in a desktop application. Now you can easily integrate geo-
spatial information with personal or business data, giving you a competitive advantage
in an agile world. And, you can link it to Groove “for a rich geo-collaboration
experience” so that you can share your map views with others.
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The Ten Habits of Highly Successful Groovers

Mark Ryan (technical specialist, Microsoft Office Groove 2007, Microsoft Business Division)
listed his top ten habits for Groove on his blog at http://marktryan.spaces.live.com/blog/:

| was packing to go to Milan tomorrow and the phone rang - A Microsoft partner, who is
rolling out a large deployment of Groove for an Enterprise customer, was calling to see if
| had any “Best Practices” in using Groove that | could share. | did so | will now share
them with you:

Groove Workspaces are a tremendously powerful tool for supporting collaboration across
domains and businesses, but we should be conscious the fact that the tool is as good as
it's users and we need to add some “house rules: to make it work effectively. Here are
some things to consider:

1.

All members can read everything. If you don’t want someone to see something, don’t
invite them in.

. Information Rights Management (IRM) will prevent unauthorized access to documents

in Groove; so, if you have a connection to the IRM-issuing AD domain, you can use
the document as your rights permit.

. Be careful to whom you allow “invite” permissions. If you don’t personally know

them, think about it!

. Groove is a great security and transport container, but its version control is not

sophisticated. Make your own folders and copy docs in there for editing, switch on
version tracking in Word, for example, and when you are ready the space manager
can merge versions using Word.

. Talk to each other—phone, email, IM, and Groove messages are great ways to agree

who should be doing what—it’s more human and very democratic to discuss how revi-
sions should be made.

. If you don’t want a doc to sync, put it in a new folder and turn off “synchronization”

RH click the folder and click Properties tab, click the Synchronization tab, and set to
Manual. When you're ready to share, switch it back to Automatic.

. Try and invite your membership in before adding too much content; this makes the

joining process quicker for the members. Then add your content a little at a time.
Groove has excellent compression algorithms which work best on smaller chunks. As
Groove is going to attempt to serialize the data into 1MB chunks anyway, you may as
well help the process.

. As the workspace manager, it's your “private club,” so why not use the Notepad tool

to create a “Welcome” or “About” page where you can outline the do’s and don’ts,
working practices, and maybe some useful links. This is a good way to induct new
members into the workspace.
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9. Remember F7 checks spelling! Make yourself look good!

10. Pressing the “Shift” twice in quick succession invokes the Send Groove Message
dialog, even if Groove is running in the background.

NOTE

To Groove with the best of them, you need to find others who are groovy, just like your-
self. One great location is a Groove user group at http://grooveuser.org/default.aspx.
Its stated goal is to allow you to “Share your Groove Experiences, learn from Groove
experts and novices, and let your voice be heard in Microsoft and beyond.” It's a great
location for both novices and experts to bond.

Groove in a Nutshell

These past few chapters might have been a real eye-opener. So many new technologies
came out this year, and they were all lumped under one grouping, and so it might be
easy to miss the benefits of Groove. Chapter 4, “Groove Server 2007: Overview and
Installation,” introduced you to the necessary infrastructure that is already in place

to allow you to communicate and collaborate with anyone, anywhere. That chapter
explained the installation process, in case you decide there is a need for an in-house
Groove environment.

Chapter 5, “Groove Server 2007: Configuration,” moved forward into a discussion about
the three main Groove servers: Manager, Relay, and Data Bridge. This information is
helpful even if you decide to have your Groove services hosted by Microsoft, because you
can still “manage” the environment through the Web console provided to you.

Finally, in this chapter, we have discussed the client. It’s the most essential piece to the
puzzle (at least from an end user’s perspective). This chapter has shown you the behind-
the-scenes side to the client, because although you can figure out a program pretty
quickly, the deeper features take time to learn. This chapter should save you that time.



